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Using Write to View This Document
To make this document easier to read, you can enlarge the Write window to its 
maximum size. To do so, click the Maximize button in the upper-right corner of 
the window. Or open the Control menu in the upper-left corner of the Write 
window (or press ALT+SPACEBAR), and then choose the Maximize command.

To move through the document, press PAGE UP or PAGE DOWN. Or click the 
arrows at the top and bottom of the scroll bar along the right side of the Write 
window.

To print the document, choose Print from the File menu.

For Help on using Write, press F1.

Help!
Any time while playing Widget Workshop, you may press F1 for help. This will 
open a Windows Help file about Widget Workshop for Windows. Also, for help 
and hints about how to use a part, double-click on the part and Doc will give you 
some pointers.

Windows Version Special Issues
Be sure to check out the "Win95/Goodies" folder on your CD-ROM for some
other cool stuff!!

Here is some helpful last-minute information specific to the Windows version of 



Widget Workshop.

Additional Mouse/Keyboard Shortcuts
There are some shortcuts when using the mouse to cut/move/point. While using 
the Pointer as your main tool, hold down one of the following keys to temporarily 
activate the Cut or Move tool: Cut = Shift key, Move = Ctrl key.

The Huge Work Area
The Windows version of Widget Workshop has a potentially huge Work Area. 
This is great if you want to make huge widgets, but can be inconvenient if you 
want to see your whole widget at once, or if you want to share your widget with 
someone who has the Macintosh version of Widget Workshop (which has a 
smaller Work Area).

Because of this, we've added a couple of special features to the Windows 
version: 
1. Fit Work Area... has been added to the Edit Menu. This is a feature that 
automatically moves all the parts of your widget closer together so they'll fit onto 
a smaller space. It won't remove any parts or connections, but it might not look 
very pretty--and most of the text labels won't be put into the right places. So you 
may want to clean up the widget after you shrink it.
2. Whenever you save a widget or Stand-Alone widget that is too big to be run on
a Macintosh, you will be asked if you want to automatically shrink it so it'll fit on a 
Macintosh. 

Sound Switch / Microphone Issues
The Sound Switch will only work if you have a sound card that supports a 
microphone--and, of course, you also need a microphone.

If you have a sound card that supports a microphone (and you have a 
microphone) and still have problems with the Sound Switch, make sure your 
microphone is connected to your sound card's Microphone jack. If the switch still 
isn't working properly, contact the vendor or manufacturer of your sound card and
have them set up your sound card properly for microphone input.

Sound Recorder / .WAV File Importing

Widget Workshop's Sound Recorder device can import about 3-4 seconds of any
standard .WAV audio file. If the playback sounds too slow, too fast, or un-natural, 
use a third-party sound editor program to conform the .WAV file to the following 
parameters: 8-bit, Mono, 11.025 KHz sampling rate.
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Slow, Erratic, or "Choppy" Performance
Video performance may appear choppy or sluggish. This is due to the difference 
in performance between video cards. Certain video cards can only go so fast. 
Video memory and the overall speed of the video card directly influences 
performance of the product.

Also, Widget Workshop must update sound as well as video. If your widget 
appears to be sluggish when running, turn off the sound. Turning off the sound 
will increase performance of some widgets.

When playing lots of sounds at once, you may notice a change in volumes. Be 
prepared to adjust your speaker volume as necessary.

Memory Issues
The bigger the widget you build, the more memory you'll need. Parts that use 
sound--like the Sound Recorder--use up the most memory. If you're building a 
widget and run out of memory, you can free up some memory by quitting all 
Windows programs except Widget Workshop and Program Manager. If you still 
run out of memory, try to use less sound parts.

When you run out of memory, a dialog box will warn you that you're out of 
memory and suggest that you save your widget. SAVE YOUR WIDGET! Then 
quit Widget Workshop and any other applications you have running. After that, 
you can restart Widget Workshop and reload your widget.

If you see an error message that says, "Widget Workshop is unable to record 
sounds," this means you're out of memory.

If you see an error message that says, "An error occurred while writing to disk.  
Your disk is probably full," and you're disk is not full, this means Widget is out of 
memory, too.

If you see a red X over a sound part, it means that you're out of memory and the 
sound part won't work.

Memory may also be an issue in running widgets (regular or stand-alone) that 
you get from other people. If they have more memory than you, they can create a
Widget Workshop for Windows Last Minute Information 3



widget that is too big to run on your computer. If this happens, try quitting all 
programs except Widget Workshop and Program Manager. If you still don't have 
enough memory, you may be out of luck (unless or until you add more RAM to 
your computer).

Mac vs Windows: Portability issues
We've taken the time to make sure that saved widgets from all versions of Widget
Workshop are as compatible as possible, but there are a few details you should 
be aware of when porting widgets from Mac to PC or vice versa:

» When porting widgets from Windows to Macintosh (or vice versa), you will need
a third-party conversion program to convert the different versions. PC Access, 
Access PC, or PC Exchange are a few of such programs which will allow you to 
convert PC files for use with the Macintosh. 

In addition, widgets from the Macintosh must be renamed to have a .WGT 
extension before they can work under Windows. And before widgets from 
Windows can work with the Macintosh version of Widget Workshop, you must 
use a utility program like Disktools or ResEdit to make sure the file's Type is set 
to Gadf and the file's Creator is set to Gadg. 

One more thing: since the Work Area in the Windows version can be much larger
than the Work Area in the Macintosh version, if you want to share your widgets 
with someone who has the Macintosh version of Widget Workshop, be sure to 
keep your widget from spreading out too far, or let Widget Workshop 
automatically shrink it for you with the Fit To Work Area... item in the Edit menu.

Printing Issues
If you receive a low memory message when trying to print a widget, you may 
need to increase the amount of free memory available in Windows (quit all 
programs except Widget Workshop and Program Manager). 

Mouse Distance Measurer Calibration
The Mouse Distance Measurer is a part that lets you measure distances with 
your mouse. Every mouse and mouse driver is different, so even though it should
be pretty accurate for most mice, it can be calibrated to be more accurate with 
your mouse.

To calibrate it, use a ruler to mark an exact distance (like 4 inches) on a piece of 
paper. In Widget Workshop, measure the distance with the Mouse Distance 
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Measurer--be sure to move the mouse SLOWLY when measuring. If it measures 
too short, then you need to increase your mouse's sensitivity. If it measures too 
long, then you need to decrease your mouse's sensitivity.

To find the sensitivity adjustment, look in Program Manager's Main group, 
double-click the Control Panel icon, then the Mouse control panel.

Technical Help
If you have trouble running Widget Workshop for Windows or get error messages
(heaven forbid!), here are some basic helpful tips. 

Most technical problems involve one or more of these issues:
1. Conflicts with other programs concurrently running under windows
2. Memory: the amount of RAM you have
3. Video card installation and drivers
4. Sound card installation and drivers

The first thing to do is to find the documentation and disks that came with 
Windows and with your video and sound cards and keep them handy.

Conflicts with Other Programs
One of the great things about Windows, is that it lets you run more than one 
program at once. The drawback is that sometimes these different programs don't 
get along--they fight over memory or other resources. If you have trouble running
Widget Workshop along with any other program, exit all programs but Widget 
Workshop and Program Manager.

Memory
Widget Workshop is a memory hog. It'll use all you've got--and more! If you've 
got the minimum 4 MB RAM you should be OK. If not, then you may need to 
make sure your Windows Swap File is big enough. For details on the Windows 
Swap File, see your Windows manual.

If you run out of memory while building a widget, you will see an "Out of Memory"
message. When this happens, you should delete some of the widgets' parts and 
make your widget smaller (so it'll fill less memory). Sometimes, you might not 
even have enough memory to delete parts. If this happens, then save the widget,
exit and restart Widget Workshop then reload the widget. If you still can't delete 
parts, then save it again, exit and restart Widget Workshop again and reload the 
widget again. The second time should be the charm.

Video Card Installation and Drivers
There are a lot of different video cards, and they all work a little differently. That's 
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why they all have special "interpreter" software, called drivers. Programs like 
Widget Workshop can talk to the drivers and the drivers talk to the video cards. If 
it weren't for drivers, software makers would have to redesign all their programs 
(and rip out their hair in frustration) every time a new video card came out. 

The gist of this is that you have to have the right driver for your video card, 
especially to work with a program like Widget Workshop, that works best with 
your monitor set to 256 colors. 

Please refer to the documentation and disks that came with your video card for 
details and drivers. Phone numbers for many video card manufacturers can be 
found in the Widget Workshop Quick-Start Guide.

Here are some special notes on particular types of video cards:

Cards with the Cirrus Logic Chipset
Certain older drivers shipped with Cirrus Logic video cards may be 
incompatible with Widget Workshop for Windows. Make sure you have the
absolutely most recent versions of the video drivers for your card or use 
the Microsoft Generic SVGA drivers, available on most online systems or 
from Microsoft.

Diamond Stealth 64 DRAM/VRAM
>>Important! Really Important!<< If you have a Diamond Stealth 64 
VRAM or DRAM video card, you need to disable all "Power Saver" 
features (even the DOS ones)! Otherwise, your system may inexplicably 
power off while Widget Workshop is in the foreground.

Problematic Video Drivers
The following video drivers are not compatible with Widget Workshop.  
Please contact the manufacturer of your video card to update your drivers.
See page 10 of the Addendum/Quick-Start Guide.

Kelvin video driver Ver 1.2
Genoa 32i  (VGA4A8T.DRV)
Acer 524 Accelerator Ver 1.32 (

Sound Card Installation and Drivers
There are almost as many sound cards as there are video cards, and they need 
their drivers, too. Please refer to the documentation and disks that came with 
your sound card for details and drivers. Phone numbers for many sound card 
manufacturers can be found in the Widget Workshop Quick-Start Guide.

Problems with Sound
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If your computer hangs up (stops working) when you play sounds in Widget 
Workshop, make sure you have the latest drivers for your sound card. If that 
doesn't fix it, then you (and we) most likely have a problem with your actual 
sound card. Some sound cards fool Widget Workshop and tell it that they can 
play more than one sound at a time, but they can't. 

To fix this, there is a way to make Widget Workshop play only one sound at a 
time. Here's what you need to do:

1. BE CAREFUL! You are about to edit an .INI file. Please follow these 
instructions carefully, and don't change anything else in the file.
2. From Program Manager, open the File menu and select Run....
3. In the Command box, type: notepad widget.ini [Enter]
4. When Notepad opens, find this line (it'll be near the top):

;SimpleSoundPlease=1
5. Delete the semicolon (;) so it looks like this:

SimpleSoundPlease=1
6. Save the file and exit Notepad.

Now Widget Workshop will only play one sound at a time no matter what your 
sound card tells it--and no more hangups! (Note: this may make your widgets run
a little slower. If you turn off sounds by clicking on the sound button in the Control
box, they will run at normal speed.)

If you change your sound card or update your sound drivers, you want to put the 
semicolon back in and test it. If it hangs up, remove it again. 

The SimTown Demo
We have found some problems running the demo on a 4 MB machine.  Try 
increasing the size of your swap file.

Getting More Technical Help
Besides the documentation for your computer, Windows, your video card and 
your sound card, there is another source of technical help.

The Maxis Tech Support crew gathered solutions to the most common problems 
that our customers have, and put hem into a Write file. This file is on the Widget 
Workshop CD, and is called Techtips.wri. When Widget is installed, an icon is 
created for Techtips.wri, but the file won't be copied to your hard drive, so you'll 
have to put the Widget Workshop CD into your drive to view it.

How to Reach Maxis Customer Support
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What To Do Before You Call Customer Support
Before you call Customer Support, please be sure that you have read this file 
and any other appropriate material first. When you are at your wit's end, 
scratching your head and grumbling, read on to find out what to have ready when
you call, so that we can get you up and running as quickly as possible. 

Note: Please make sure that your computer system meets or exceeds the 
requirements defined on the system label. The system label is located in the 
lower-left portion on the front of the box or on the spine of the box. If your 
computer doesn't meet these requirements, then there's nothing Maxis Customer
Support can do for you. Sorry.

What You Should Have With You When You Call
1. Have a printout of your WIN.INI and SYSTEM.INI files as well as your 
CONFIG.SYS and AUTOEXEC.BAT files. You can easily print all of these files by 
typing MSD <ENTER> at the C: prompt. This will run the Microsoft Diagnostics 
program which will allow you to print out a report of your system. If you can't print
out your system files (you don't have a printer), it isn't the end of the world, as 
long as you are at your computer when you call! 

2. If you are getting error messages or General Protection Faults (GPFs), write 
down exactly what the error message says. That will help us diagnose the 
problem.

3. Write down all of the steps you have taken to solve the problem. If we know 
what you've already done, we may be able to get you running faster.

4. Have your program disks, your manual, and your Quick-Start Guide available 
and within easy reach.

Where You Should Be When You Call
Please, please, when you call us, be in front of your computer! We need to have 
you at your computer to explore your system to identify what is causing your 
problem.

Let's Do the Numbers!
There are a number of different options that you can use to contact Customer 
Support. The best way to reach us is by e-mail, FAX, or telephone. If you decide 
that you would like to call and hear a friendly voice, you'll find the number for 
Customer Support listed on the Maxis Maxims sheet, included in the box your 
program came in. There's lots of other useful info there, so keep your Maxis 
Maxims somewhere handy.

In order to better serve you, we have established an automated Support service 
Widget Workshop for Windows Last Minute Information 8



in addition to our live Support team. Automated Support is available 24 hours a 
day, 7 days a week. By calling our Customer Support technical line, you may 
select automated Support in lieu of live assistance. Calling during non-Support 
hours will automatically prompt you for automated Support. Automated Support 
allows us to help you find a solution quicker, and helps to reduce on-line waiting 
time.

We are on all of the major on-line services and the Internet if you subscribe to 
any of these services. If you don't currently subscribe, many on-line services will 
give you a 30-day trial membership. Refer to the Maxis Maxims for more 
information.

If you have a modem, on-line support is often the best option. We maintain a 
BBS that is free-of-charge (excluding long distance charges from your phone 
company) to all registered users of Maxis products. The BBS number is (510) 
254-3869 and it is available 24 hours a day, 7 days a week. We support up to 
14.4k bps and currently have four nodes. The settings are 8-N-1. You can also 
find the latest FAQs (Frequently Asked Questions), hints and tips from other 
users and other good stuff.

Fill in that card!
Make sure you register your software! We've included a handy little postcard for 
you to send in. This will entitle you to FREE Customer Support for the life of the 
product. The product life ends when a new version is released or the product is 
discontinued.

Widget Workshop™ for Windows, ©1995 Maxis
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